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Chapter 1  
Installation

  System Requirements

Your Requirements

for Creating Demos

Viewer Requirements for

Playing Demos

Windows 3.1 or higher

486 CPU, 33 MHz

8 MB of RAM

8 MB of hard disk space

VGA monitor, 256 colors
recommended

A mouse or other pointing device

AVI drivers required if playing AVI
files in your demos

SB compatible sound card
recommended

Windows 3.1 or higher

486 CPU, 33 MHz

4 MB of RAM

VGA monitor

A mouse or other pointing device

Sound card (if demo contains sound)

Contents
System Requirements 1-1

Installing DemoShield 1-2

   Installing from Diskette 1-2

   Installing from CD 1-2

   The DemoShield Program Files 1-3

   CD Extras 1-4

What Can You Do With DemoShield? 1-5
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  Installing DemoShield

  Installing from Diskette
Windows 3.x,  Windows NT
3.x

Windows 95, Windows NT 4.x

1. Insert the Program 1 Disk in a
diskette drive.

2. Open Program Manager.

3. Select Run from the File menu,
and type a: setup on the
command line.  (Type a different
letter instead of a if you are using
a different drive, such as b.)

Alternately, you could use File
Manager to view the files on the
diskette, and double-click
SETUP.EXE.

1. Insert the Program 1 Disk in a
diskette drive.

2. From the Start menu, choose
Settings: Control Panel.

3. Double-click the Add/Remove
Programs icon.

4. Click the Install/UnInstall tab.

5. Click the Install button.
Windows should automatically
locate the installation program,
SETUP.EXE.

  Installing from CD
Windows 3.x,  Windows NT
3.x

Windows 95, Windows NT 4.x

1. Insert the CD into your CD-ROM
drive.

2. Open Program Manager.

3. Select Run from the File menu,
and type d: install on the
command line.  (Use a different
letter instead of d if you are using
a different drive, such as e)

Alternately, you could use File
Manager to view the files on the
CD, and double-click
INSTALL.EXE.

1. Insert the CD into your CD-ROM
drive.

2. From the Start menu, choose
Settings: Control Panel.

3. Double-click the Add/Remove
Programs icon.

4. Click the Install/UnInstall tab.

5. Click the Install button.
Windows should automatically
locate the installation program,
INSTALL.EXE.
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  The DemoShield Program Files
DemoShield is actually two main programs: the Designer (full program) and the
Player (run-time version).

  The Designer
The Designer is the application you will use to create, edit, and test run your
demos. The Designer file is DESIGNER.EXE (Windows 3.x) or
DESIGNER32.EXE (Windows 95/NT).  If you are installing and using
DemoShield on a network system, make sure you have write privileges to the
subdirectory where the Designer is located if you wish to use Auto Save.

  The Player
The Player is a smaller, executable program file that you must include with your
demo on your distribution media. The Player can run a demo but cannot be used to
create a demo.  The Player file is DEMO.EXE (Windows 3.x) or DEMO32.EXE
(Windows 95/NT). The Player executable has a required library file, DS.DLL
(Windows 3.x) or DS32.DLL (Windows 95/NT).

  The Setup Wizard
The Setup Wizard (SETUP.EXE in the Wizard subdirectory) is the program you
use when you are ready to distribute your demo on disk or CD.  This wizard is a
subset of InstallShield, the leading application for installing Windows
applications.  In a few simple steps, the Wizard walks you through the process of
creating the compressed installation file(s) that you will distribute to your
viewers via disk, CD-ROM, or other means.  When your demo is installed, your
end-user simply double-clicks an icon in your new program group (or folder) to
launch the demo.

  The Knowledge Base
The Knowledge Base is an online reference tool created and maintained by our
Technical Support staff. The Knowledge Base  provides up-to-date information about
the most current version of DemoShield, including Frequently Asked Questions, and
articles on designing demos using particular techniques.  Periodic updates to this file
will be provided for online access via the WWW and CompuServe.

  Sample Demos
These demos are examples of how you can use DemoShield5 to create all types of
outstanding demonstrations.  Simply double-click on a demo icon to view the demo.
To study and/or modify a demo, open the demo file using the DemoShield Designer.
Refer to the Knowledge Base for articles on how each demo was constructed.
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  CD Extras
These applications were shipped as “CD extras” with your copy of DemoShield5 at
the time of the program’s initial release.  Each of these programs is a tool that can
help you create professional-looking demos.  These programs are located on the CD
only.  They are not available on disk.

  Lotus ScreenCam
Lotus ScreenCam is a tool that records both sound and screen activity on your PC as
screen movies.  These movies are recorded and play back full screen.  You may play
these movies (SCM files) in your demo through the Play Video action, which can be
triggered when your viewer clicks a button, or at a particular time in the scene.
ScreenCam has a required run-time file called SCPLAYER.EXE that you must
include when distributing demos that play SCM files.

ScreenCam is installed on your system as part of the standard installation.  If you
did not install it, simply run the DemoShield installation again and select only the
ScreenCam components to install.  For more information on ScreenCam, see the
Knowledge Base.

  Cambium Sound Choice Lite
This is a superior collection of royalty-free music clips produced for professional
multimedia applications.  Since the sounds are in WAV format, your end-user will
not need any special files to hear the music--just a  standard sound card and
speakers.  To import these files into your demo, choose Manage Demo Resources
from the Demo menu, click on the Sound tab, click the Import button, and browse to
locate the WAV file you wish to use.

  Media Commander Express

Media Commander Express is a tool you can use while creating your demosor
anytime you wishto visually manage all of your video, sound, text, and image files.
Media Commander Express can be installed from the MEDIAEX subdirectory on the
DemoShield CD.
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  What Can You Do With DemoShield?
Use DemoShield to create an interactive, multimedia demonstration to show or sell
any product, service, or idea.  Create presales demos, software Quick Tours, product
tutorials, and other applications to demonstrate your product or service with
maximum impact.

You will also find there are a number of creative applications that you can design
with DemoShield.  You can create an electronic résumé, a storyboard for a video
production, a multimedia family album—the possibilities are endless.

  A Special Focus on the Needs of Software Developers

In order to meet the special needs of software developers, DemoShield includes a
number of features and tools which make it the ideal choice for demonstrating
software applications.  These features include the new AppCam Wizard, which helps
you capture a sequence of screen images and cursor movements to simulate your
application in action.  You may also play video recordings of your running
application saved as ScreenCam Movie (SCM) or Audio-Video Interleaved (AVI) files.
In addition, DemoShield offers you the ability to launch live applications (including
installation programs) from a demo file.  Demos created on Windows 95/NT systems
can be distributed via the Internet so your viewers can play them directly from your
web site.

To help you get started, we have provided “template demos” for several of the most
common demo types, which are described below.  When you create a new demo with
our New Demo Wizard, you will be asked to choose one of these demo types.  When
the new demo opens, you may view and edit it to meet your needs.

  Presales Demo
A persuasive demonstration that describes and/or advertises a product or service to
potential customers.  Presales demos typically introduce the new product, promote
features and describe benefits, and provide sales contact information.  You may also
provide a Price List for your viewers to print out.  Presales software demos typically
include a simulation of the application being described.

  Quick Tour
A Quick Tour demo introduces new users to your software application.  Typically,
users are given the opportunity to launch a Quick Tour from the product’s Welcome
or Startup dialog box, as well as through the Help menu.  The overall goal of a Quick
Tour is to make your new users feel comfortable and satisfied with your product.
One of the best ways to do this is to create an interactive Quick Tour that allows
your viewers to explore only the aspects of your application that most interest them.
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  Cue Card
An online information system that provides step-by-step instructions for performing
specific tasks. A Cue Card is usually displayed in a very narrow window so that it
can run alongside an open application.

  Tutorial
A computer-based tutorial (CBT) is a file, or set of related files, whose purpose is to
teach, guide, or instruct a user.  Tutorials are usually one-to-one, or intended for
viewing in small workshop/seminar groups.  DemoShield allows software developers
to create a live application demo.  This is a demo where your end-user can interact
with your application in real time.  For example, your demo could launch the
application, and then play a macro demonstrating a particular task.  Then your
viewer would be given the opportunity to try it.  An effective computer-based
training (CBT) tutorial should include as much user interaction as possible.  Tests
may also be used, both at the beginning of the tutorial, to direct the experienced user
to more advanced modules, as well as at the end of the tutorial, to reinforce material
already presented.

  CD Browser
A CD Browser demo provides a graphical user interface (or front end) for launching
other applications.  For example, a software publisher may wish to distribute a CD
containing evaluation-only versions of several new applications.  Rather than simply
placing all of the executables on a CD, the publisher could create a DemoShield
demo that would allow the user to select an application, go to a scene or scenes
describing the application, and press a button when ready to launch the application.
Upon closing the application, the viewer would return to the demo's menu scene and
could select another application to explore.

If you installed this version of DemoShield from a CD, you have already seen a CD
Browser demo.  The DemoShield CD Browser provides a user-friendly way for our
customers to install the products they have purchased, as well as to view
information on additional company products and services.

  Press Demo
A Press Demo can be thought of as a “multimedia press release,” which lets you
easily communicate the look, feel, and concepts behind your new product or service
to members of the media.  Impress editors with detailed product information coupled
with top-notch graphics and sound.  Demonstrate a key feature; then let your
potential reviewers “try it for themselves” in an environment where you can provide
the guidance to ensure a successful experience with your new product.
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  Creating a New Demo File

The purpose of this Basic Tutorial is to teach new DemoShield users the concepts
and skills needed to create any type of demo.  If you are already familiar with
DemoShield, you may wish to skip ahead to Chapter 3, the New Features Tutorial.

  Launching DemoShield

■ To launch the Designer on a Windows 3.1 or Windows NT system:

Double-click on the DemoShield Designer icon in the DemoShield5 Program
group in Program Manager, or double-click on DESIGNER.EXE in File
Manager.

■ To launch the Designer on a Windows 95 system:

Choose Start|Programs|DemoShield5|DemoShield Designer.  The
Designer launches and you see the Welcome dialog box shown in Figure 2-1.

Take the Tour!  

Click the Quick Tour button on the
Welcome dialog box to view a
demo that visually teaches you the
key terms and concepts used in
DemoShield.  When the demo ends,
you will return to the Welcome
dialog box to begin creating your
new demo.

Document Conventions
Click  =  Click left mouse button.

Choose =  Select from a menu or combo box.
Submenus are indicated in the following way:
File|Play Demos|Configure Demos.

Check = Click to select a check box item or a
radio button.

Clear = Click to deselect a selected check box
item.

Dialog Box = A window that appears in order to
exchange information with the user.

Bold  (in steps) = We will use bold in steps to
indicate characters you must type in exactly, or
items to choose from a menu, list, or dialog box.

     Example:  1.  Type 40 in the Exit time field.

Italics =  We will use italics to indicate key
terms.

CAPS = Filenames and pathnames will be
capitalized.
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Figure 2-1. The DemoShield Welcome dialog box.

■ To start creating your demo.

1. Click on Create New Demo.

2. Click OK.
The New Demo Wizard launches to assist you.

  The New Demo Wizard
The New Demo Wizard launches when you check Create New Demo from the
Welcome dialog, or choose New from the File menu.  The New Demo Wizard assists
you in creating a new demo by asking a few questions about the type of demo you are
creating and how you want your demo to look.

Based on your responses, the Wizard then creates a new demo file based on one of
our professionally-designed demo templates.  This new demo will contain fully
configured scenes, each with several objects you can edit as you wish.
■ To use the New Demo Wizard:

Make the selections as shown in Figures 2-2 through 2-7.

After each selection, click Next to proceed to the next Wizard dialog box.
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Make the selections as shown in Figures 2-2 through 2-7

Figure 2-2.  Select the Presales Demo  type.

Figure 2-3.  Select Asymmetric for Demo layout and Demo
Region Size  for Application layout.

Template Demos
DemoShield5 comes with
several “template demos” that
you can modify.  These are
fully configured demos, each
designed to meet a specific
need.

For example, the Presales
Demo type you are selecting
for this tutorial is a template
demo which contains a
number of scenes which help
you describe and sell your
software application to
prospective customers.
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Figure 2-4.  Check Windowed  for the demo style.  Accept the
default size of 640 x 480 pixels.  Check Centered  and Fixed
Size Demo .  These selections will create a demo that will play
in a VGA resolution-size window on any viewer’s screen.

Figure 2-5.  Click the small “up arrow” or “spin” button to the left
of “Feature” to create 2 Feature Scenes .

What is a windowed demo?
A windowed demo is a demo that
plays in a window on your
viewer’s screen.  You can specify
the size and location of the demo
window. When you create a fixed
size windowed demo, you disable
scaling for all objects in your
demo. This means all your text,
graphics, etc., will retain their
original size and position on the
screen.  This type of demo is
easier to design than a full screen
demo.

What is a full screen demo?
In a full screen demo, objects will
scale (i.e., grow larger or smaller)
so that the demo fills the viewer’s
screen, regardless of the
resolution.  Sometimes you will
need to disable the scaling of
individual objects to retain their
relative positions.  For example, a
hot spot may need to appear
directly over another object.
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Figure 2-6. Use the slider bar or the left and right buttons
under the preview window to view the available color
scheme choices. Click Next when you have selected one.

Figure 2-7. Click Finish . Your new demo is built!
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  The DemoShield Screen
Figure 2-8 shows the DemoShield Designer screen, open to your new demo.

The Designer Window (in the middle) is the screen your viewer will eventually see.
To design your demo, you will place objects on the screen that serve various
functions.

To the right of the Designer Window are four floating panels with tools and controls
useful in developing your demo.  All new demos have the default name of
DEMO.DBD.  The Status Bar at the bottom of the screen reports your cursor
location and several important details about the object currently selected.

Figure 2-8.  This is the DemoShield Designer screen.  If any of the tools shown here are missing,
choose their names from the View menu.  The tools below the Controller are the Auto Shapes
Palette (left) and the Object Palette (right).  To create an object, click a button on one of these
palettes and click in the Designer Window.  Click the Play button on the Controller to “test run” a
scene in the Designer Window.  The names of all objects in the scene (whether visible at the
current scene time or not) are listed in the Scene Editor.



2-8 Chapter 2

  Setting Preferences
Before we begin, we need to ensure that certain user preferences (customizable
options) are enabled.

■ To set preferences:

1. Choose Preferences from the File menu.

The Preferences dialog box opens to the Enable tab.

Figure 2-9. Your Enable tab should match this one.

2. Check or clear the options to match the dialog box shown in Figure 2-9.

3. Click OK.

Get Help understanding the DemoShield interface
At first, the number of tools, palettes, and windows used in the Designer can be
overwhelming.  But Help is available.

1. Choose Contents from the Help menu.

2. Click on Introduction to DemoShield.

3. Click on DemoShield: A Visual Tour.

4. Click on Designer Tools and Palettes.

For details on how to use each tool or palette, click on the More About hypertext
links.  You will view an illustration of the tool or palette.  Click on any area of
the illustration to see details on using that part of the tool or palette.
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  LESSON 1: Editing Text Objects

Now that the New Demo Wizard has built your initial demo file, you are ready to
start personalizing the presales template to meet your needs.  Let’s begin by
changing the properties of a few Text Objects in the first scene.

  Displaying Title Text
In our first scene, there are two Text Objects that display titles.  One object displays
the company’s name; the other displays the title of the demo itself.  The steps to edit
these objects are provided on the next few pages.

  Entering the Text Shown (Object Styles)

1. Click on the words “Company Name” in the scene entitled #Intro.  This is a
Text Object which you can use to display text you type in yourself, paste from
the clipboard, or import from a Rich Text Format (*.RTF) file.  “Handles” appear
around the object T Company Name to indicate that it is selected.

2. Now double-click on the same object.  The Text Properties dialog box opens to
the General tab (Figure 2-10).

 

What are properties?
Every object you place on the screen has what we call properties.  You can
think of properties as adjectives that describe the object: a red circle, a gray
background, a three-dimensional push button, a 24-point bold Arial font, the
value of a variable.  Each of these attributes is a property you can edit.

What is an object?
An object is anything you can put on the Designer Window screen.  It can be
visible to your viewer, such as a Text Object.  Or it might be invisible, such as
an AVI Object, serving only to perform a special function, perhaps playing a
video.  In DemoShield, an object performs the same role as that of an actor in a
movie.  It appears on the scene, performs some function, and finally exits the
scene.  A single scene may contain up to 256 objects.  You use the Object
Palette (shown in Figure 2-8) to create most DemoShield objects.
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Figure 2-10. When you open an object’s properties dialog box for the
first time, the General tab appears on top.

3. Click on the Object Styles tab (Figure 2-11) to edit the text shown.
4. Click in the large edit field with the words “Company Name.”
5. Delete the text shown, and type in your own Company Name.  Type any

characters you want.  You can force a line break by pressing Enter.

Figure 2-11. Type the text you want to display in the large edit field provided in the Object Styles
tab (left).  To set margins, select alignment, and import *.RTF files, click the Options  button.
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  Choosing Fonts
Whenever possible, choose a font you know your viewers will have on their systems.
You can reasonably expect your viewers’ systems to have the fonts that ship with
Windows 3.1 and higher: Arial, Courier New, MS Serif, MS Sans Serif, Symbol,
Times New Roman, and Wingdings.

When a viewer runs your demo, DemoShield looks first for the font you selected.  If
that font is not on the viewer's system, DemoShield tries to create a TrueType Arial
font.  If the viewer’s system does not have TrueType Arial, or any TrueType font,
DemoShield uses the Windows system font.

1. Click the Font tab (Figure 2-12).

2. Change the font type and/or style as you like.

3. Select a new point size, if you wish.  If the point size that you want to use is not
listed, you may type in your own selection in the Point Size field.

Figure 2-12.  Choose from the list of fonts and specify the point
size and font style.  A preview of the chosen font is shown in
the lower right corner.

  On Your Own
 Use the steps explained previously to edit the Demo Title object (T Title) to

display the title of your new demo.

Click the Forward and
Back buttons to scroll
through the tabs.

Right-click on any
inactive area in a
Properties dialog box to
view this tab shortcut
menu.  Left-click on the
tab you want to see.
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  Displaying Body Text
Now we will edit the T Main Text object, which contains the body text for this
scene. Unlike title text, body text should be set in a serif font for greater readability.

[TIP:  Try to display the text in a narrow window of no more than 6 words per line.]

1. Open the Properties dialog box to the Object Styles tab.

2. Replace the default text with new text that describes the purpose and goal of
your demo.  You may:
• type it directly in the edit field, or
• use CTRL+C to copy text from another file and CTRL+V to paste it into the

edit field

 If you wish to force a line break, press Enter for each return required.  For
example, we typed:

 Welcome!

 Click >> to see how easy it is to create interactive, presales
demonstrations just like this one!

3. Click the Font tab to select a serif font (such as Times New Roman).

4. Click OK to close the dialog box, and view your changes.

Figure 2-13.  To make an object smaller or larger, click and drag on a handle.

Your pointer
will change to
a sizing cursor
when you move
it over a handle.
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  Resizing Objects
Most likely, the new text you entered will require you to resize and/or reposition the
object on the demo screen.  To resize an object:

1. Click to select it.  Handles will appear around the object.

2. Click on any handle.  Your pointer changes to the sizing cursor, shown in Figure
2-13.

3. Drag in to make the object smaller; drag out to make the object larger.
DemoShield will wrap the text to fit the new object size.

  Positioning Objects
To move an object on the screen, you can:

• Click in the middle of the object, and drag it to its new location, or

• Click to select the object, and press the arrow keys on the keyboard to
“nudge” the object one unit at a time (one pixel by default) .

To display a visible grid that may help you position objects, choose Grid from the
View menu.  If you wish to see the object’s exact size and location, select it, and view
the right side of the Status Bar at the bottom of your screen.  The X and Y
coordinates refer to the object’s location on the screen relative to the upper left
corner.  The Height and Width numbers refer to the object’s size in pixels.  The Life
number refers to the object’s life in seconds (see Lesson 5 for a discussion on an
object’s Life Properties).

  Borders
If you prefer, you may create a border around your body text that gives the object the
same appearance as that of an application window.  You may select a caption as well
as a Close button that will hide the text object when the viewer presses it.

To modify the type of border around your text, click the Borders tab (Figure 2-14)
and make your selections.
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Figure 2-14.  Text border options.

The “Welcome” body text shown in Figure 2-15 is an example of the window border style.

Figure 2-15.  The body text in the middle of the screen appears with an
application border window.  When your viewer runs the demo, he or she can
“close” the window—that is, hide the object—by clicking the Close  button.
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  LESSON 2: Displaying Images
1. Double-click on the “Your Logo” graphic (Figure 2-15) to open its Properties

dialog box.

2. Click on the Fill Styles tab (Figure 2-16).  Experiment with the various fill
styles available to see how they change the appearance of the rectangle as shown
in the preview window.  End by re-selecting the Image fill style.

3. To display a graphic that is not currently a resource to your demo, click the
Import Image button.  Use the browse box to replace the default graphic with
your own bitmap or metafile image, and click OK.

4. If the graphic you are using is a bitmap (*.BMP), you will need to select an
Image Option.  Choose from the following:

• Standard:  The image is cropped from the upper right corner to fit the
size of the object.

• Crop Image:  The image is cropped from the center to fit the size of the
object.

• Resize Image:  The image will stretch or shrink as necessary to fit the
object’s size. (Usually distorting the bitmap.)

• Tile Image:  The image is replicated to fill the size of the object.  (Image
size remains the same.)

• Resize Frame:  The object is resized to fit the size of the bitmap image.

5. Click OK to close the dialog box.

Figure 2-16. Click on the name of the image you wish to display, or
click Import Image  to browse for a new image.
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  LESSON 3: Modifying Scene Properties

Now that we have edited the text and graphics in our first scene, let’s make some
minor changes to the properties of the first scene.

  Editing Scene Length and Transition
Just like objects, scenes have properties you can modify.

1. Double-click on any blank area within the scene.

The Scene Properties dialog box opens to the General tab (Figure 2-17).

2. Change the Scene Length to 10.5 seconds.

Note:  You can enter scene length in tenth of a second intervals (example: 10.3).

3. Select the transition effect called Vertical Blinds.

This means that a special effect will be performed during the transition period
when this scene ends and the next scene begins -- it will look like vertical blinds
opening and closing.

In this example, our scene transition is Go to Next Scene.  However, we don’t
have to go to the next scene.  We could choose to go to another scene, or select a
Pause on Scene transition where the demo would pause until the viewer
provided some action to continue the demo -- such as clicking a button.

What is a scene?
A scene is an organizing principle in DemoShield.  Every demo contains one or
more scenes.  Just like in a play or movie, a scene in DemoShield lasts a certain
amount of time, and provides some information or sets the mood for scenes to
follow.  Unlike a play or movie, however, your scenes in DemoShield do not
have to simply play from first to last.  With DemoShield, you can create an
interactive demo—a demo where your viewers’ clicks and keystrokes affect
what they see and hear in the demo.  You may have up to 512 scenes in one
demo. Each scene may contain up to 256 objects and may run from one second
to 27.775 hours.
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Figure 2-17.  Edit the scene properties as shown.

  Test Running the Scene in the Designer
Let’s try out that new scene transition.

Click the Play button on the Demo Controller (Figure 2-18).

Figure 2-18.  The Demo Controller.

When the clock reaches 10.5 seconds, the scene transition begins, and after
approximately one-half second, the next scene appears in the Designer Window.

Click the Stop button on the Controller to stop the demo playback.

This second scene is named #Navigation.  It contains several wide buttons that your
end-user can click to navigate to other scenes in the demo.  Clicking on any Home
button in the demo will bring you to this scene.

Play

Next Scene

Stop
Previous Scene



2-18 Chapter 2

  LESSON 4: Editing Interactive Buttons

When the viewer presses the Feature1 button shown in Figure 2-19, the demo goes
to a scene named Feature 1a.  Likewise, pressing the Feature2 button will switch
the demo to the Feature 2a scene.

Figure 2-19.  Clicking on the bitmap button selected above triggers an
action to go to a scene describing the product’s first key feature.

A bitmap button is a push button that can display an image along with, or in place
of, a caption.  DemoShield also has a Button Object that does not display images, but
can appear as a radio button, check box, or push button.

What is an interactive object?
These are objects your viewer can interact with while the demo is running.
Your viewer provides an “event”— a mouse click, a key press, typing
characters, even just placing the mouse on an interactive object—which
triggers an “action” that you have built for that interactive object.  These
objects include buttons, bitmap buttons, hot spots, popup menus, listboxes,
and navigational VCR Buttons like those that appear at the bottom of each
scene.
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  Changing a Button’s Appearance
1. Open B Feature 1 to the Object Styles tab (Figure 2-20).

2. Change the Button Caption to the name of a feature you wish to describe in your
demo.

If you need to resize the button, you can type in new Width and Height values.

Note: You cannot resize a bitmap button by clicking and dragging its handles.  Keep in mind
that to keep a consistent button appearance, you would have to edit the size of all buttons used
in the demo.

1. Choose the Inside caption position.

2. Click the Fill Styles tab and choose the Transparent fill style.

3. Right-click to access the shortcut menu; left-click on Font Color.

 

Figure 2-20. Bitmap Button Object Styles.

7. Click on one of the 16 standard colors shown in Figure 2-21 or type in specific
Red, Green, and Blue values to create a customized color.  You may also use the
color slider bars or buttons to adjust the R, G, B values.  In this particular scene,
a white or other light-colored font will provide the best contrast.
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Figure 2-21.  Click a color, or type RGB values.

  Changing a Button’s Action

In this section, we will explain how to create the actions that have been built for the
Feature 1a button in #Navigation scene.

1. Click the Play button on the Controller (Figure 2-18) to test run this scene.

2. Place your mouse on top of the Feature1 button.
You will notice that a block of text appears.

3. Click the Feature1 button.  The Feature 1a scene appears.

4. Go back to #Navigation scene by selecting its name from the Scene Editor.

5. Open the Properties dialog box for the Feature1 button (B Feature 1) to the
Actions tab.  (Remember to right-click on any inactive area to view a shortcut
menu of all tabs.)

What are events and actions?
When your viewer clicks a button on your demo screen, or moves the mouse on
an object, it is an event.  When your demo does something in response to that
event, it is an action.  When the demo switches to another scene, for example,
that is an action.
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6. In the combo box under the words “When the viewer does this,” scroll up to the
top to select Summary of All Events as shown in Figure 2-22.
A list of all the actions linked to this button is shown.

Figure 2-22. Choose Summary of All Events to see all the actions
triggered by an interactive object.

7. Choose the Left-Clicks Mouse event from the top combo box.  Now only the
actions triggered when the viewer left-clicks the mouse are listed.

8. Click the Delete Action button.  The action selected is removed from the list.
Now we will rebuild this action for the left-clicks mouse event.

9. Click the New Action button.  The Build Action Wizard launches (Figure 2-23)
to help you select an action for the demo to perform.

Figure 2-23. Use this dialog to choose from more than 30 DemoShield actions.
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10. Choose the action Go to Scene, and click Next.  The dialog shown in Figure 2-
24 appears.

Figure 2-24. Since the Go to Scene Action was already selected, this
screen appears to allow you to select the scene the demo will show.

11. Choose the scene named Feature 1a, and click Finish.

12. Click OK to close the object’s properties dialog box.

Now we will go through the steps to build a Moves Mouse On Object action to show
the Text Object T Feature1 when the viewer places the mouse on the Feature1
button.

1. Double-click on the name T Feature1 in the Scene Editor (Figure 2-25) to open
the object’s properties dialog box.

Figure 2-25.  You may use Scene Editor to access both objects and scenes.

Click the Scenes List combo box to switch to
another scene.

Click an object’s name to select it.
Double-click its name to open its properties
dialog box.
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2. In the General tab, you will notice that the box marked Visible is cleared for the
object’s Initial State.  That means this object will be invisible until it is linked to
a Show action which makes the object visible.

3. Click on the Object Styles tab, and replace the default text with the text you
wish to display.

4. Click OK to close the properties dialog box for T Feature1.

5. Double-click on B Feature1 to open its properties dialog box, and go to the
Actions tab.

6. Use the combo box under the words “When the viewer does this,” to scroll to and
click on the Moves Mouse On Object event.

7. Click Delete Action.

8. Click New Action.

9. Choose the action Show, and click Next.
A new dialog appears, asking which object you wish to show.

10. Select the object T Feature1, and click Next.
A new dialog appears, asking for the duration of the Show action.

11. Select Scene Duration, and click Finish.
The Build Action Wizard closes.

12. Click OK to close the object’s properties dialog box.
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  LESSON 5: Object Timing, Motions & Effects

In this lesson, you will learn how to set the timing for both the entrance and exit of
objects within a scene.  You will also learn how to select motions and/or special
effects that may be performed at various times during an object’s lifespan.

  Setting Start, Hold, End, and Exit Times
1. Choose the menu command Control|Go to Scene|#Special Offer.

2. Double-click in an empty spot on the scene background to open the Scene
Properties dialog box.

3. Change the Scene Length to 10 seconds, and close the Scene Properties dialog.

4. Double-click on T Title (the text object that reads “Special Offer Title”).

5. Right-click anywhere in the dialog to bring up the tab shortcut menu, and left-
click on Life.  This opens the Life Properties dialog box (Figure 2-26).

6. Click to insert your cursor in the Hold edit field.  The object’s Hold time is the
scene time when the object reaches its Hold position (the X and Y coordinates
where you created it) onscreen.  Type in 1.5 as the Hold time.  Since the object’s
Start Time is 0.0 seconds, we are giving this object 1.5 seconds to move into the
scene.

7. Press Tab to advance to the End edit field.  The object’s End time is the scene
time when the object begins to exit the scene.  Type in 8.5 as the End time.

8. Press Tab to advance to the Exit field.  Type 10.0 as the Exit time.  Since the
object begins exiting when the scene time reaches 8.5 seconds, it will take 1.5
seconds for the object to finish exiting the scene.

What is life?

Each object that your viewer will see onscreen has what we call Life
Properties.  These are settings that determine when and how an object appears
onscreen, holds onscreen, and then disappears from the screen.  An object’s
life within a scene is the total time it exists onscreen.
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Figure 2-26. Use the Life tab to set an object’s timing,
and to select motions and/or effects to be performed
during various periods in the object’s life.

  Choosing Motions
You will notice that there are three radio buttons under the words “Life Periods.”
These are the three Life Periods:

• Start Period:  The period of time when the object makes its entrance onto the
scene (Hold Time minus Start Time).

• Hold Period:  The period of time when the object appears where you created it
onscreen (End Time minus Hold Time).

• End Period:  The period of time when the object makes its exit from the scene
(Exit Time minus End Time).

For each of these three time periods, you can select an effect.  For the Start and End
Periods, you can also select a motion.  Rather than explain what motions and effects
are, let’s just show you!

1. Click the Start radio button under Life Periods.

2. In the combo box that appears next to the word “Motion,” scroll to and click on
Appear from Right to Left.

3. Click the End radio button under Life Periods.

4. Choose the motion Disappear from Left to Right.

5. Click OK to close the object’s properties dialog box.

Point-to-Point Motion
Instead of choosing a
preset Motion to move
an object into or out of
the scene from the edge
of the screen, you can
create point - to - point
motion.

For example, to choose
the location where an
object will begin
appearing, click the
Start button, and click
Capture. Click on the
screen location of your
choice.
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6.  Choose Control|Play Scene.

 The T Title object moves into the scene from the right edge of the screen.  When
the scene time reaches 1.5 seconds, the object holds where you created it
onscreen until the scene time reads 8.5 seconds.  Then the object begins to move
to the right until it disappears at the right edge of the scene at 10 seconds.

7. Click the Stop button on the Controller to stop test running the scene.

  Choosing Effects
Now we will edit the text inside the T Main Text object and create a special effect for
this object’s Start Period.

1. Double-click on the object T Main Text to open its properties dialog box.

2. Click on the Object Styles tab and change the text inside to read:
 Purchase our software within the next 30 days to receive:

3. Right-click on an inactive area of the dialog, and left-click on Life.

4. Click on the Start radio button under Life Periods.

5. Use the lower combo box next to the word “Effect” (Figure 2-27) to choose
Random Bits Appearing.

6. Change the object’s Start time to 1.5 and Hold time to 3.0.

7. Click OK to close the object’s properties dialog box.

8. Resize the object as necessary.

9. Test run the scene using the Controller.  You will notice that this time, the object
does not move on the screen, but instead slowly fades into view.

Figure 2-27. Choosing a special effect for an object’s entrance.
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  LESSON 6:  Creating Objects

Each new object that you add to your scene contains initial properties which you can
edit to meet your needs.  These are default properties and are derived from a
DemoShield template (*.TPL) file.  The name of your current template file is shown
at the bottom of the Object Palette.

  Creating Auto Shapes
Now we will create a few new objects in the scene named #Special Offer.  We will
begin by adding three new Auto Shapes.

1. If you do not see the Auto Shapes Palette onscreen (Figure 2-28), choose
View|Auto Shapes Palette.  (It may be underneath the Object Palette.)

Figure 2-28.  Auto Shapes Palette.

2. Click the Square Point button shown in Figure 2-28.

3. Click in the Designer Window.  Your pointer changes to a cross-hair cursor.

4. Drag in any direction.  The object grows larger or smaller as you drag.

5. When the object is similar in size and shape to the bullets shown in Figure 2-29,
click again.  The object is closed.

6. Open the object’s properties dialog box to the Background Color tab and choose
an appropriate background color.

Square Point
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  Duplicating and Aligning Objects
1. Click to select the new object.

2. Click the Duplicate Object button  on the Toolbar at the top of your screen.
A copy of your first square point shape appears to the right of the original.

3. Click and drag this copy below the original graphic.

4. Repeat the previous steps to create a third “bullet” point graphic.

5. Now, hold down the Shift key while you click to select all three of the bullets.  A
“lasso” appears around the objects to indicate that they are selected (Figure 2-
29).

Figure 2-29. Hold down the Shift  key as you click to select multiple objects.

6. If the Aligning Tools do not already appear onscreen (Figure 2-30), choose
View|Aligning Tools.

7. Click the button on the far left.  Your objects are now left-aligned.

8. Click the button second from the right.  Your objects are now evenly spaced
vertically.

Figure 2-30.  Use this tool to align selected objects.

Evenly Spaces
Objects VerticallyLeft Align
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  Creating Objects with the Object Palette
Now, we will create three new text objects to serve as “bullet point items” for our
#Special Offer Scene.

1. Click the Text Object button on the Object Palette (Figure 2-31).  (If you do not
see this tool on your screen, choose its name from the View menu.)

A p p C a mListBox

Line

AVI Object

VCR But ton
Buttons or  Check Box

Variable

Group Object

Appl icat ion Object

Poly-Line
Polygon

Bi tmap But ton

Event Object

Edit Field

Sets Edi t ing Mode

Text Object

Hot Spot

PopUp Menu

Figure 2-31. Use the Object Palette to create all DemoShield objects except for Auto
Shapes.

2. Click in the Designer Window.
A new text block appears displaying the words “Right-Click Here.”  Its default
name is Text 1.

3. Position the object on the scene just to the right of the top bullet graphic.

4. Change the text inside to display one bullet point item.

 For example:  Free Priority Technical Support

5. Using the steps explained earlier, change the Font to Times Roman 12 pt.
bold and the Font Color to an appropriate color.

6. Duplicate this object twice.

7. Place one of the new Text Objects next to the middle bullet graphic, and the
other next to the bottom bullet graphic, as shown in Figure 2-32.

8. Edit the text inside Text 2 and Text 3 to display your own text.
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Figure 2-32.  This is the Special Offer Scene with our new objects.

  On Your Own
If you wish to experiment with the various motions and effects available for objects,
you might edit the Life Properties of the six objects we just created.

For example, one nice visual effect would be to have the bullets move into the scene
with an Appear From Top motion, while the text objects might merely pop onto the
scene (the Show effect with no motion effect) just as the bullets reach their hold
positions.
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  LESSON 7: Using Resources

DemoShield allows you to easily incorporate images, text, sound, video, and other
resources created with outside software applications into your demo.  The first step
in using these resources is to import them into your demo file.  Some resources, such
as images, can be imported directly from the object that will display them.  However,
other resources must be imported first via the Resource Manager dialog box.  These
resources include file, sound, and video resources.

  Resource Manager
1. Choose Demo|Resource Manager.

2. Click Files.  The dialog in Figure 2-33 appears.
You should see two files listed:  #Contact Info Order and #Special Offer Order.
They are both actually the same file, ORDER.WRI.  This is a generic order form
that we have created for your use.

Figure 2-33.  Use this dialog box to import, export, remove, rename,
and view information about the current resources in your demo.

3. If you already have an appropriate order form, save it in *.WRI or *.TXT format,
and use the Import button in this tab to import the resource.
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4. If you want to edit the order form we have provided, click to select either of the
resources and click the Export button.  Use a word processor such as Windows
WordPad to edit the file, save it, and return to this tab to reimport the resource.

5. When you have the resource ready, click OK to close the Resource Manager.

  Building or Editing a Print File Action
Now that we have imported a printable file resource, we can edit the Print File
action to allow a viewer to print the new order file from the running demo.

1. Go to the #Special Offer scene.

2. Click the button named B Print Order Form.

3. Open its properties dialog box to the Actions tab.

4. Click Edit Action.  The dialog shown in Figure 2-34 appears.

Figure 2-34. Choose the Print File action.

5. Use the File Resources combo box to select the resource you wish to print.

6. Click Finish.

7. Click OK to close the properties dialog box.

Note:  There is also a Print Order Form button in #Contact Info scene that you may wish to
modify in the same manner, if you have replaced the generic order form resource.

Congratulations!  You have completed the Basic Tutorial.  Continue to the
next chapter to learn how to use some of the New Features in DemoShield5.1.
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Before You Begin
If you completed the Basic Tutorial in the previous chapter, you have already created the demo
that you will need to use in the tutorial in this chapter.

If you did not complete the Basic Tutorial, please turn to pages 2-3 and follow the instructions
for launching the New Demo Wizard.  Select the options shown in Figures 2-2 through 2-7.
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  LESSON 1: Creating an AppCam Resource

In this lesson, we will create an AppCam resource to demonstrate a software
application.  For this example, we will demonstrate the Windows accessory Notepad.

Figure 3-1.  Selected is the Automation Object that will play your AppCam
resource.  If you want your simulation to take up a larger or smaller portion of
the demo screen, click and drag on the object’s handles to resize it.

What is an AppCam resource?
An AppCam resource is a type of automation resource that you can use in
your demo to simulate a running application.  An AppCam resource
contains one or more sequences of screen image and cursor point captures.
When your AppCam resource plays in your demo, the viewer's cursor will
be moved in real time to the cursor points that you captured.

AC
Automation
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  Launching the Automation Wizard

1. Go to Feature 1A scene.
You will find a black rectangular object called AC Automation (shown in Figure
3-1).  This object represents the “frame” in which your AppCam resource will
play.
You may resize this object if you wish.

2. Right-click on the object.
A popup menu appears.

3. Left-click on Edit Automation.
The Automation Wizard dialog box appears (Figure 3-2).

Figure 3-2.  The AppCam automation type is already selected.

3. Click Next.
The dialog in Figure 3-3 appears.
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Figure 3-3. After you click Begin , you can launch your application.

4. Click Begin.

 The Automation Wizard minimizes, and a small Automation Capture dialog box
appears (Figure 3-4).

Figure 3-4.  This dialog simply reminds you to open your application.

5. Start the Windows accessory Notepad.
From Windows 95:   Choose Start|Programs|Accessories|Notepad.
From Windows 3.1:  Double-click on Notepad in the Accessories program group.

6. After Notepad opens, click the Done button on the Automation Capture dialog.
The Wizard dialog shown in Figure 3-5 appears.
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Figure 3-5.  This dialog will launch the AppCam Automation Sizing Window.

6. Click Begin.
7. Click on Notepad, and resize the window to fit inside the transparent area of the

AppCam Automation Sizing Window, as shown in Figure 3-6.

Figure 3-6. The AppCam Automation Sizing Window.

8. Click the Done button in the Sizing Window.

Notepad
Title Bar
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The Wizard dialog shown in Figure 3-7 appears.  You are now asked to capture
your background window.  This is usually your main application window.
However, it could be a dialog box or anything else you wish to use as the base
image for your AppCam resource.

 The image you are about to capture will serve as the backdrop for your AppCam
resource playback.  Your subsequent image and cursor point captures will be
displayed on top of this image.  For this reason, your background window should
be larger than any other window you plan to capture.

Note:  The sizing window is merely a guide to help you size your application window to fit in your demo.  In
the next step, you will capture your main application window.  This is the key step.  The image that you
capture will serve as the “base” image for all image and cursor point captures to follow.

Figure 3-7. This dialog prompts you to capture your background window.

9. Click Begin.  The Designer minimizes, and the Capture dialog appears set to the
Window Under Pointer capture type (Figure 3-8).

Figure 3-8.  Use this dialog to toggle between
image and cursor point captures.
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10. Click on the Notepad title bar (indicated in Figure 3-6),  and press the Ctrl key.
The Wizard dialog shown in Figure 3-9 appears.  Now you will begin capturing
your new image and cursor point captures.  As we noted earlier, these images
are all relative to the background window you captured first.

Note:  Do not move or resize your background window until you have finished capturing all the
sequences in your AppCam resource.

Figure 3-9. This dialog explains how to capture images and cursor points.

  Capturing Your First Sequence
1. Click Begin (Figure 3-9).

2. Click on the Notepad title bar and press Ctrl to gain focus.

3. Place your cursor over the Edit menu to highlight it, but don’t click on it yet.

4. Press Shift+Ctrl to capture the cursor position.

5. Click on the Edit menu to display it.

6. Press Shift+Ctrl to capture the window image.

7. Place your cursor over the Time/Date command to highlight it, and press
Shift+Ctrl to capture the cursor point.

8. Press Shift+Ctrl again in the same spot to capture the window image.



3-8 Chapter 3

9. Click on Time/Date.
The current time and date are added to the document.

10. Click on the Notepad title bar, and press Ctrl to capture the window image.

11. Click the Done button on the Capture dialog.
The Automation Viewer Wizard dialog appears (Figure 3-10).

Figure 3-10.  Use this dialog to test your AppCam resource.

 If more than one sequence appears, you should merge the sequences.  As you can
see in Figure 3-10, a sequence is shown with a black bar.

12. To merge sequences, right-click on the earlier of the two sequences—that is, the
black bar that is further to the left.  A popup menu appears.  Left-click on Merge
Sequences.

13. Click Test Play to see the AppCam you have captured.  When the AppCam has
finished test playing, you will return to the dialog shown in Figure 3-10. (Do not
close this dialog.)

  Capturing Your Second Sequence
1. Click Add.

The Automation Capture dialog box reappears.
2. Press the Caps Lock key, and click in the Notepad window after the date.
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3. Hit the Enter (return) key twice, and type
TYPE MESSAGE HERE.

4. Press Ctrl to capture the window image.
5. Place your cursor over the File menu to highlight it, but don’t click on it yet.
6. Press Shift+Ctrl to capture the cursor point.
7. Click to display the File menu.
8. Press Ctrl to capture the cursor point.
9. Press Shift+Ctrl to capture the window image.
10. Move your cursor over the Save menu item to highlight it, but don’t click on it

yet.
11. Press Shift+Ctrl to capture the cursor point.
12. Press Shift+Ctrl to capture the window image.
13. Click Save.

The Save As dialog appears.
14. Click on the dialog’s title bar to gain focus, and press Ctrl to capture the window

image.
15. Type a name for the file.
16. Click again on the title bar, and press Ctrl to capture the window image.
17. Move your cursor over the Save button (but don’t click on it) and press Shift+

Ctrl to capture the cursor point.
18. Click the Save button.
19. Click on the Notepad title bar and press Shift+Ctrl to capture the window

image.
20. Press the Done button on the Automation Capture dialog box.

The Automation Viewer dialog box appears again.  Now you will see additional
sequence(s).

21. If necessary, merge the new sequences so that you have only two sequences: the
first sequence, which showed the Time/Date feature, and the second sequence,
which showed how to type text and save the file.
To merge a sequence, right-click on the earlier sequence—the one to the left—
and left-click on Merge Sequences.

22. Click Test Play to test your AppCam resource.

23. Click Next to bring up the AppCam Save dialog (Figure 3-11).



3-10 Chapter 3

Figure 3-11.  Use this dialog to save your resource.

24. Type a unique name for your AppCam resource, and click Save Automation.

25. Click Done to close the Wizard and return to the Designer.

 Your new AppCam resource appears in the demo (Figure 3-12).

Figure 3-12.  The beginning of your Feature 1a  scene.
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  LESSON 2: Creating a SoftPhrase Resource

Now we will create a SoftPhrase resource to provide text that will accompany the
AppCam playback.  We will begin by editing the existing SoftPhrase resource in the
Feature 1a scene.

  Editing The Existing SoftPhrase Resource
1. Right-click on the large block of body text that appears to the left of your

AppCam resource.  This object is named SPh Automation.

2. Left-click on Edit Automation.  The dialog shown in Figure 3-13 appears.

Figure 3-13.  This dialog appears when you click Edit Automation .

3. If you wish to change the reading speed of the SoftPhrase, you may do so now.

 

What is a SoftPhrase resource?
A SoftPhrase resource is a  sequence of automatically timed text phrases that play in your
demo as a unit.
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4. Press the Next button three (3) times, until you reach the Automation Viewer
dialog (Figure 3-14).

Figure 3-14.  In this dialog, you can edit the text itself and change formatting properties.

5. Right-click on the small magenta graphic at the far left of the sequence bar.

6. Left-click on Edit Text.
The Text Editor dialog box shown in Figure 3-15 appears.

7. Delete the text shown, and enter the following:

 Notepad's Time/Date command allows you to display the current time
and date in your documents.

8. Click OK to close the Text Editor dialog and return to the Automation Viewer.
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Figure 3-15.  Use this dialog to edit the text displayed.

9. Right-click on the magenta graphic (text element) again, and left-click on
Properties.  The Text Element Properties dialog (Figure 3-16) appears.

Figure 3-16. Use this dialog to change the formatting of the
text for each individual SoftPhrase sequence (text block).
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10. Make any changes you wish to make to the Text Properties, and click OK.
For example, you may wish to check Add Window Border in the Options tab to
choose an application window-style border for your text phrase.

  Adding a SoftPhrase Sequence
1. Click the Add button (Figure 3-14).

The SoftPhrase Text Editor (Figure 3-17) opens.

2. Type in the following:

 Use Notepad to type messages, letters, anything you wish.
By default, Notepad saves your file in *.TXT format.

3. Select the text you just entered, and click the Add Phrase button.

4. Click Done to return to the Automation Viewer dialog.

Figure 3-17.  You must select the text you wish to add.

5. Click Next to advance to the Save dialog.

6. Click Save Automation.

7. Click Done.
The Designer reappears.  Your scene should look something like Figure 3-18.
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Figure 3-18. Decrease the width of SPh Automation  so that the text
fits within the available space.

15. Click on the SoftPhrase object (SPh Automation) and resize the text block so
that it fits on the screen.

16. Use the Controller to test play your scene.

It’s likely that your SoftPhrase sequences do not match up exactly with the
AppCam sequences they are describing.
In the next lesson, we will synchronize the timing of these sequences, and
provide a short pause between the playback of these two sequences.
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  LESSON 3: AutoSync

In this lesson, we will synchronize the timing of each AppCam sequence with the
appropriate SoftPhrase sequence.  When we have completed this task, we will save
our work, and both resources will be edited simultaneously.

1. Choose Automation from the Demo menu.
The Automation Wizard initial dialog (Figure 3-19) appears.

Figure 3-19.  Click AutoSync to launch the Automation Wizard -
AutoSync.

2. Click AutoSync to launch the Automation Wizard - AutoSync (Figure 3-20).
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Figure 3-20.  Select the resources you wish to synchronize.

3. Click to select the AppCam and SoftPhrase resources shown above.

4. Click Next.
The AutoSync Automation Viewer dialog (Figure 3-21) appears.

5. Click the Zoom In or Zoom Out buttons in the upper right corner of the
preview window to adjust the view as necessary to see the entire length of the
first AppCam and SoftPhrase sequences.

As you can see in Figure 3-21, a thin gray line in the middle of the preview
window separates the AppCam sequences (top) from the SoftPhrase sequences
(bottom).

6. Double-click on the first AppCam sequence.  Figure 3-22 (left) shows how the
black sequence indicator bar turns a gray color to indicate that it has been
selected.

7. Double-click on the first SoftPhrase sequence. DemoShield immediately changes
the life period of the AppCam sequence to match the SoftPhrase sequence, as
shown in Figure 3-22 (right).
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Figure 3-21.  This special Automation Viewer dialog allows you to synchronize
the lifetime of AppCam sequences with SoftPhrase sequences.

Figure 3-22.  When you double-click on a resource, it turns gray to indicate it’s selected
(left). Double-click on the resource you wish to match it with.  Both sequences now
have the same life span as the SoftPhrase sequence.
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Before we synchronize the second set of sequences, let’s move the second SoftPhrase
resource ahead in time by a second or two to provide a break in the playback of the
two sequences.

8. Click on the black sequence bar for the second SoftPhrase resource, and drag it
to the right to move it ahead in time by a second or so after the initial sequence
ends, as shown in Figure 3-23.

9. Double-click on the same SoftPhrase resource.  The sequence indicator bar turns
gray.

10. Double-click on the second AppCam resource.  The sequence length is changed to
match the length of the SoftPhrase resource.

Figure 3-23.  You may wish to move the second SoftPhrase sequence
ahead in time so that it does not overlap with the first sequence.

11. Click Save.

12. Click Cancel to return to the Designer.

13. Test play the scene.
Figure 3-24 shows the first SoftPhrase sequence, playing in conjunction with the
first AppCam sequence.  The second sequences of both AppCam and SoftPhrase
resources are shown in Figure 3-25.
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Figure 3-24.  The first AppCam and SoftPhrase sequences.

Figure 3-25.  Later in the scene, the second SoftPhrase and
AppCam sequences play together.
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  LESSON 4: Editing Demo Properties

Several new features have been added to the Demo Properties dialog box to control
how your demo appears when viewed through the DemoShield Player.  The Player is
the run-time version of DemoShield that your viewers will use to watch your demo.

1. Choose Properties from the Demo menu.  The dialog box shown in Figure 3-26
appears.

Figure 3-26. Click the Options tab.

2. Click the Options tab (Figure 3-27).
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Figure 3-27.  In this dialog, you may type in an ending message to pop
up onscreen for a second or two after the demo closes in the Player.

3. If you wish to display an Ending Message for a few seconds after the viewer
closes the demo, type in the characters you wish to display.  Your message may
contain up to 33 characters.

4. Click the Styles tab.
As you can see in Figure 3-28, this is the dialog that controls the Windowed
Playback Style options.

5. Since this is a windowed mode demo, you may make the following optional
selections:

• Full Screen Background.  When this property is disabled, your demo window
displays on your viewer’s screen on top of any other open windows.  If you
would prefer to fill the viewer’s screen behind the demo window with a
background color, check this box.

• Window Caption.  You may edit the default caption as you wish.  Or, you
may click Eliminate Caption to display your demo window without a title
bar.  However, if you do not display a caption, your viewer will not be able to
move the demo window around on the screen.  Alternately, you could choose
to display the current scene name as the caption.
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Figure 3-28.  Use this dialog to choose a caption for your demo
window, and to trigger the display of a background color to fill the
viewer’s screen behind your demo window.

5. If you chose Full Screen Background in the previous step, click the Background
Color tab now.  Choose the color that you would like to display behind your
demo window.

6. Click OK to close the Demo Properties dialog box.

Now that you have decided how you want your final demo to look to your end-users,
let’s test it using the DemoShield Player.

Keep up to date with the Knowledge Base
Refer to the DemoShield Knowledge Base for technical articles and tips and tricks on
new DemoShield5 features.

Please take a minute to read the Recent Changes article within the ReadMe section.  This
article describes last-minute enhancements made to DemoShield5 following the release
of the printed documentation.  The DemoShield5 Help file is also an up-to-date source of
information on performing specific tasks.
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  LESSON 5: Test Running in the Player

Thus far in the tutorial, we have tested the demo exclusively in the Designer
Window.  While this provides a convenient way to test motions, effects, and many
actions, we still don’t have a true feel for how the completed demo will look on our
viewer’s system.  The only way to view a demo exactly as your end-user will see it is
to test run the demo through the DemoShield Player.

1. Save your demo (*.DBD) file.

Choose File|Play Demos|Play Current Demo.  Figure 3-29 shows an
example of a demo with a window caption and full screen background color
selected.

Figure 3-29. An example of how a completed demo might appear on your viewer’s system with
“XYZ Software Demo” chosen as the window caption.

To exit the demo, press Escape, or click an Exit button to reach the Exit Scene. You
can wait 5 seconds for the scene to end, or click the Exit button to exit immediately.

Congratulations!  You have completed the New Features tutorial.
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